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When creating a WordPress website, everyone makes mistakes. However, each mistake
is a learning opportunity that helps you grow. In setting up our own websites as well as
helping others, there are some common WordPress mistakes to avoid to save time,
money, and grow your business more effectively. The goal is to help you learn from

other people’s mistakes when making your own websites.

1. Choosing The Wrong Platform: The biggest mistake people make when
starting out is choosing the wrong blogging platform. Basically, there are two
types of WordPress. First, there is WordPress.com which is a blog hosting service,
and then there is WordPress.org also which is the famous self-hosted WordPress
platform that everyone loves.

You need to start with self-hosted WordPress.org because it gives you access to all
the features you need out of the box.

2. Buying More than What You Need: To get started with a WordPress
website, you need a domain name and WordPress hosting. The challenge is that a
lot of domain registrars try to upsell other services. This confuses the small
business owners who are just starting out.

The add-on services may include privacy protection, extra email accounts,
security services, and more.

You can skip all of these things and save money to spend on growing your
business. If you later decide that you need those services, then you can always
purchase them from your hosting company.

You also need to choose the right hosting plan for your website. For 90% of
websites that are just starting out, a shared hosting account is quite enough to get

you going.
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3. You Cannot Upload Themes
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Once you've logged into your WordPress site via the login form, you should be presented
with the WordPress Dashboard, which is your site’s admin area. WordPress dashboard
is the interface where administrators or other users manage website page, posts and

perform other tasks. So let’s dig right in...
4.1 What is the WordPress Dashboard?

WordPress dashboard is the interface that appears when you log in to your WordPress
website by appending wp-admin to the URL of your website. Hence if your website is
https://www.example.com/ The WordPress dashboard login URL for this website would
be https://www.example.com/wp-admin/

Dashboard
Ata Glarce Quick Draft

* B

WordPress News

Activty

WPTrainMe

The dashboard contains various settings which help you set up your website efficiently
and modify several aspects of your site without needing to FTP to your site or touch the
WordPress database.

Your WordPress administration section is where all of your site’s administration is
controlled from. Your Dashboard is divided into several areas that provide you with

access to tools and features such as:
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If you want to start a blog, then WordPress.com offers a hassle-free solution to get
started. But the actual question is, what do you want to do with your Blog? A lot of
people just want to share their personal thoughts, ramblings, photos and such. For that
purpose, WordPress.com offers a free, easy to use, secure and stable platform for you to
blog on. However, if you want to do more with your blog such as make money, build a
membership community, among other things, then there are some inherent limitations.
Let’s take a look...

1. Earning Limitations
You cannot run Google Adsense or other advertising programs to serve ads on
your WordPress.com blog. You cannot write paid posts, sell links, review
products, ete. WordPress.com terms of service restrict you from using your free
blog for any commerecial activity on your own. However, you can apply for
WordPress.com’s advertising program which is called WordAds. This program is
currently available to WordPress.com blogs that match certain traffic and quality
requirements. Once you are approved for WordAds program, you will be sharing

your advertising revenue with WordPress.com.
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e Useful data and information about what is taking place on your site. It also
provides you with “at-a-glance” metrics and reports about recent activity taking
place on your site, system updates, and notifications, and to be kept updated on
the latest news from the WordPress community and various WordPress-related
resources, such as notifications and announcements from WordPress product
vendors of plugins and themes that you have installed on your site.

e Management and control of all website settings and options.

e Features that let you modify, expand, update and enhance the design and
functionality of your site, upgrade plugins and themes, and add, modify and

delete content or content sections.

In version 3.8, WordPress introduced new design changes to its backend section ...

=" Pre-v.3.8
Design

)

Post v.3.8
Design

3

Even though this new design was mostly cosmetic and aimed at giving WordPress users
and developers cleaner typography for a better optimized mobile and desktop viewing
experience and a more aesthetic experience, it also affected much of the existing
WordPress documentation around the web, including thousands of tutorials and articles

about WordPress online, in print and on video that are now in need of being updated.

4.2 Your WordPress Dashboard
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Note: If you have a book, then you can have an ad for that on your
WordPress.com blog. They just don’t allow ads for products or services that you
do not own.

2. You Cannot Upload Plugins
The real power of WordPress comes from the freedom to customize and extend
the core functionality. You cannot extend the functionality of WordPress.com by
uploading plugins. You are given a comprehensive but still a limited set of
features. A lot of people who migrate from WordPress.com to self-hosted
WordPress.org do so just to take advantage of certain features that come with

these amazing plugins.
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°  Go to your WordPress theme’s page and purchase the file. Once you've
done this, you'll be taken to a screen where you can download the theme
file.

° If there is an option for it, download the “Installable WordPress Files
Only”. This will give you a zipped folder you can then upload directly into
WordPress.

°  To do this, go back into WordPress, find the Appearance tab, and go to
“Themes”. Click on “Add New” at the top. Only, this time, you’ll select the
“Upload Theme” option.

°  Select the zip file from your computer and click Install Now. With your
new theme uploaded into WordPress, you can now activate and publish it

to the site.
3.1.6 Step 6: Configure Your WordPress Theme

Upon activation, you'll want to spend some time configuring your theme. You can do

this under the Appearance tab and then click “Customize”.

Ultimately, it’s up to you to decide how much or little of your theme you want to
customize. However, you should at least take some time now to go through each of the

modules and acquaint yourself with what you have the power to change.

° Site Identity is an important one to fill in, so make sure you look at that first.
°  Colors allow to update your site to your brand’s color palette (if you have one).

°  Widgets allow you to add content to your footer.

3.1.7 Step 7: Publish Your First Pages
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such a fusion of
different genres™
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4. Themify Builder: The Themify Builder comes with a drag and drop interface
that helps you create any layout you can imagine with ease. The builder comes

with over 60 prebuilt layouts and animation effects that you can choose from.
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A WordPress theme is a pre-designed and pre-coded interface template for WordPress.
Basically, it saves you the trouble (and money) of having to design your own website

from-scratch or to pay someone else to do it for you.

‘When you log into WordPress for the first time, WordPress will automatically assign

their latest theme to your site.

Accesspress Uee an

If you want to use a WordPress theme that works better for your niche, don’t be afraid to
look around and to find the best and most trustworthy WordPress theme for your

purposes.

Keep in mind that every theme requires some configuration. Also, not every theme
works the same way. Some utilize a basic text editor (which looks similar to the blank
page in Microsoft Word) while others use a page builder or visual editor. So, switching
from one theme to another will force you to do a little rework if or when you make a
switch. If you want to spare yourself the possible hassle, then don’t move on to the next

steps until you've found the perfect WordPress theme for your site.
3.1.5 Step 5: Install Your WordPress Theme
When you find that perfect WordPress theme, it’s time install it in WordPress.

¢ Free WordPress Themes
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2. The Divi Builder: The Divi Builder is a powerful WordPress page builder that
lets you build any type of design on your website with drag and drop. The Divi
Builder is made by Elegant Themes, a renowned WordPress themes, and plugins
company.

The Divi builder works on almost any WordPress website. It gives you endless
possibilities to create the most advanced layouts without having to touch a single
line of code.

The plugin is bundled with 46 builder modules, 20 row types, and 3 section types,
all of which can be combined and arranged to create just about any type of
website. With its advanced design settings, you can customize every element to a
great extent.

That being said, if you want to make real-time changes on the design, then you
might want to use the Divi theme. With the theme, you can build your page with
the frontend editor, so your pages can be updated right from the frontend
without having to switch back and forth from your dashboard to your website.

Pricing: Starts at $89 (includes 100+ website packs)
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If you're using a free theme from the WordPress repository, here is what you need to do:

° Inside WordPress, go to the Appearance tab and click on “Themes”.

° At the top of the page, click on “Add New”. This will take you to the
‘WordPress repository from within WordPress. Use this option so you don’t
have to do any manual installation.

°  Once you're in the repository, do a search for the WordPress theme you
want to use. Hover over it, and click the “Install” button.

°  When it’s done installing, you then have to activate it in order to publish it
to your WordPress site.

°  Click on “Activate” (in the same spot where the “Install” button was) and

wait for it to take you back into the main WordPress dashboard.

Install Themes

Search | Search Results | Upioad | Featured | Newsst | Recently Updated

Tg  $ blacktwo-columnsresponsiveayou © | Search

¥ Comments

» Appearance

Themes

Twenty Fourteen Vr BPr Aspen

By wordpressdotorg By woweaver

Installed  Preview  Detalls Install Now i paa stall Now  Preview  Dstail
— —

¢ Premium WordPress Themes

If you've decided to purchase a premium WordPress theme, the process will differ as
third-party theme developers and marketplaces don’t sync directly to WordPress.

Here is what you need to do:
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The Divi Builder Plugin

A Drag & Drop Page Builder For Any

3. Elementor: Elementor is the first free and open-source advanced page builder
for WordPress. With its quick drag and drop builder, you can make instant page
edits from the frontend of your site. Elementor is well-known for its high-speed
performance, which makes it fun and easy to build with.

With its extensive template library, you get hundreds of beautiful WordPress
templates by their top-notch designers, which can be exported to different
websites through the page builder. Elementor supports responsive mobile-
friendly design, allowing you to build web pages that work great on any device.
Some other cool features of Elementor are:
e Canvas: You can build a brand new landing page without header or
footer, optimized for high conversions.
e Maintenance mode: For maintenance, you can get your site offline with
its built-in maintenance mode.
e Zapier integration: Integrating your website with a third-party web
application is a breeze using its Zapier integration.

Pricing: Starts at $49 for a single site license.
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Drag and drop WordPress website builder makes it easy for you to create and customize
beautiful websites all on your own. We'll compare the most popular drag and drop
WordPress page builders, so you can choose the best one for your needs and start

creating your site.

Note: Instead of a WordPress page builder, if you're looking for a complete CMS/

website builder platform, then check out our collection of best website builders.
9.1 Why Use a Drag and Drop Page Builder for WordPress?

When starting a blog, many beginners find it difficult to customize their WordPress page

layouts.

While a lot of premium WordPress themes come with different page layouts, most of
them are extremely hard to customize for anyone who does not know code (HTML /
CSS).

Well, there are several great drag and drop page builder plugins available for
WordPress. They allow you to create completely custom website designs in WordPress

without writing a single line of code.

Since there are so many different WordPress page builder plugins in the market, we
decided to compare and rank the top WordPress page builders, so you can choose the

right solution for your need.

Let’s take a look at what you should keep in your mind when comparing the best

WordPress page builders, so you can choose the right one for your needs.
e Compatibility:

If you're not interested in changing your existing WordPress theme for a page builder
plugin, then the first thing you need to check is whether the builder you want to use is
compatible with your WordPress theme.

If you find any compatibility issues, then you might want to use a builder-compatible

theme for your site.
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¢ Features:

You need to understand the unique quality of each builder when comparing the features.
For example, some builders are shipped with a lot of built-in layouts while others offer

dozens of animation effects.
* Responsiveness:

You need to make sure that the page builder you choose allows you to create responsive,

mobile-friendly, layouts out of the box.
e SEO:
You need to make sure that your page builder is creating SEO friendly layouts.
Having said that, let’s take a look at the best page builders for WordPress in the market.

1. Beaver Builder: Beaver Builder is a premium drag and drop page builder
plugin for WordPress. It is by far the best WordPress page builder in the market.
It is extremely fast and comes with a built-in onboarding tour to help you quickly
familiarize with their interface.

Beaver Builder comes with a live drag and drop interface. You get to see all your
changes as you add them by simply dragging elements from the right sidebar and
dropping them on your page. You can click on any element on a page to edit its
properties.

There are modules that let you add almost everything you may want including
sliders, carousel, backgrounds, content blocks, buttons, and more. It also comes
with over 30 finely designed templates for landing pages that make it super-easy
and super-fast to create stunning website layouts.

Beaver Builder has been updated well along with the Gutenberg project. So, it
works fine with your new Gutenberg editor.

Pricing: Starting from $99 for Unlimited Sites.
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hiding information in the listings section (e.g. tags, comments, etc.), specifying the
number of posts to display per page, and other configurable options depending on the

plugins you have installed on your site.
e Online Help Section

You can access the official WordPress documentation and user help forum sections by

clicking on the Help tab located on the top right-hand corner of your header area.

Like the Screen Options tab, the Help tab also displays context-specific information. So,
for example, if you are editing content in the Edit Post area, clicking on the Help tab will

bring up help information and tutorials relevant to editing posts.
4.3.2 WP Admin Area: Toolbar

The Toolbar displays at the very top of your Dashboard screen and provides you and
your logged in site users with access to a range of important administration functions,
features, information and “quick links” to other areas of your site. Most Toolbar items

can expand to display additional information by hovering your mouse over the icons.

For example, the “updates” icon on the toolbar lets you see if the WordPress software or

any plugins or themes need to be updated. You can also see at a glance ........
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WordPress Plugins allows you to easily modify, customize, and enhance a WordPress
site. Instead of changing the core program code of WordPress, you can add functionality

with WordPress Plugins.

If you're new to WordPress, you might find yourself wondering, “what is a WordPress
plugin?”. It’s a fairly common question to ask because, in addition to being one of the
many new terms that WordPress will introduce to your vocabulary, plugins are also an

essential building block of every single WordPress site. Here is a basic definition.
5.1 WordPress Plug-ins

A plugin is a piece of software containing a group of functions that can be added to a
‘WordPress website. They can extend functionality or add new features to your

WordPress websites.

Add Plugins usiosd plugin

Seacch Rosuits  Festure s Recommended  Fovorite Koyword 3 WPForms.

63 items vz >

Contact Form by WPForms WP Mail SMTP by
- Drag & Drop Form Builder WPForms
for WordPress

Styler for WpForms

More Datais

WordPress plugins are written in the PHP programming language and integrate
seamlessly with WordPress. In the WordPress community, there is a saying that goes
around: “there’s a plugin for that”. They make it easier for users to add features to their

website without knowing a single line of code.
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Depending on whether you or someone else manages your site, you may or may not see
the messages below. The first time you log into your WordPress site, you may see a

“Welcome to WordPress” message displayed at the top of the Dashboard...

If you are new to using your website and want to spend a little time learning more about
WordPress, just click on the “Get Started” or “Next Step” links. To dismiss the
“Welcome” message or prevent it from showing again inside your admin area the next

time you log in, click on the Dismiss link near the top right-hand corner of the page...

Feel free to explore the information displayed in the “welcome” message if you want to
learn about new features and updates to the software. To go back to the dashboard, just

select “Dashboard” (or click on Dashboard > Home) on the admin menu section...

Or scroll down to the bottom of the page and click on the link to dismiss the message

and return to your main Dashboard...
4.3 WordPress Dashboard Screen Areas

Your Dashboard gives you access to all of the main controls and features that you will

need to administrate the site...
Your main Dashboard screen is divided into the following sections:

e Header And Toolbar Section (1)
e Main Navigation Menu (2)

o Work Area (3)

e Footer Section (4)
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Dashboard

4.3.1 WordPress Dashboard Area: Header Section

The header section displays system updates, messages, warnings and notifications. A
whole range of updates, messages, banner, announcements, notifications, and warnings
can display on your header, depending on what area you are working on, what action

has been performed, or which plugins you have installed on your site.

e Screen Options Feature

The Screen Options tab is located in the top-right corner of your WordPress
administration screen, in the header section. Clicking on this tab displays different
options and features on your screen, depending on which section of the administration

backend you are currently working on.

For example, if you are in the main Dashboard, clicking on the Screen Options tab
allows you to configure options like which panels of your Dashboard screen you want to
hide or display. If you are in the Posts section of your site management area, clicking on

the Screen Options tab lets you select totally different options, such as displaying or
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WordPress is an Open Source software system used by millions of people around the
world to create beautiful websites and blogs. It is completely customizable by the use of

themes and plugins.

Thanks to the great community of contributors and the constant development,
WordPress has become a content management system that provides you with tons of

features to build and manage your website.

You can use the application to build any type of website: from a small personal blog or
business website to fully-featured eCommerce online store or gallery/portfolio website,
the possibilities are endless. WordPress is the ideal solution to build your online
presence, whether you are a newcomer or you already have some technical experience.
As you have a great number of plugins to extend the functionality of your website, with

no coding required you can create a professional website in just a few easy steps.

And that’s exactly what we are going to discuss in this training guide. In this guide, we
will provide you with detailed information and instructions on how you can use
WordPress to build your own website with ease. We will cover different topics like
WordPress installation, plugin and theme management, and usability. Also, you will
learn how to extend the functionality of your WordPress website and provide your

visitors with feature-rich experience.

So let’s get started...
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Alternatively, you can do this with 1-click using the Hardening feature in the free Sucuri

plugin that we mentioned above.

8.3.3 Disable PHP File Execution in Certain WordPress Directories
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self-sustaining WordPress is good enough to create and run a Library Website.
Using DMS implementation as well as WordPress one can surely develop Library
Websites.

e Personal Websites: Whether it’s a small website containing your portfolio or a
daily blog. WordPress is undoubtedly one of the best platforms to showcase your

talent as it has dedicated sections for the contents and overall easy experience.
2.4 Features of WordPress

WordPress is considered to be the most popular content management system due to its

characteristics:

e The most important features of WordPress are that you can create a dynamic
website without any programming and design knowledge

e  WordPress is theme based which provides you options for various open source
and premium design themes, which can be integrated easily without any

designing knowledge
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guarantee that they will fix your website (no matter how many pages you have). This is a

pretty strong warranty because repairing hacked websites is expensive.
8.2.4 Move Your WordPress Site to SSL/HTTPS

SSL (Secure Sockets Layer) is a protocol which encrypts data transfer between your
website and a users browser. This encryption makes it harder for someone to sniff

around and steal information.

STEP 1

Browser requests a connection

* ( *)

Server sends certificate with public key

STEP 2

Browser checks certificate validity

Encrypts data using the public key

‘ (e}

Server decrypts the data using the private key
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Once you enable SSL, your website will use HTTPS instead of HTTP, you will also see a

padlock sign next to your website address in the browser.

SSL certificates were typically issued by certificate authorities, and their prices start
from $80 to hundreds of dollars each year. Due to the added cost, most website owners

opted to keep using the insecure protocol.

To fix this, a non-profit organization called Let’s Encrypt decided to offer free SSL
Certificates to website owners. Their project is supported by Google Chrome, Facebook,

Mozilla, and many more companies.

Now, it is easier than ever to start using SSL for all your WordPress websites. Many

hosting companies are now offering a free SSL certificate for your WordPress website.

If your hosting company does not offer one, then you can purchase one from
Domain.com. They have the best and most reliable SSL deal in the market. It comes

with a $10,000 security warranty and a TrustLogo security seal.
8.3 WordPress Security for DIY Users

If you do everything that we have mentioned thus far, then you're in pretty good shape.

But as always, there’s more that you can do to harden your WordPress security.
Some of these steps may require coding knowledge.
8.3.1 Change the Default “admin” username

In the old days, the default WordPress admin username was “admin”. Since usernames
make up half of the login credentials, this made it easier for hackers to do brute-force

attacks.

Thankfully, WordPress has since changed this and now requires you to select a custom

username at the time of installing WordPress.

However, some 1-click WordPress installers still set the default admin username to
“admin”. If you notice that to be the case, then it’s probably a good idea to switch your

web hosting.
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blogging site, WordPress can be used to build an e-commerce website, portfolio sites,
business websites, new sites, and more. Famous WordPress websites include
TechCrunch, Mashable, The New York Times’s blog, etc.

Some of the features offered by WordPress are private and password protected
WordPress posts and pages, easy importing, WordPress installation and upgrades, a full
WordPress theme and plugin system, multiple authors, spam protection and intelligent

text formatting. So, ‘WordPress is only limited by your imagination’.

With its intuitive interface, ease of use and the great number of free and paid themes
and plugins, WordPress is the preferred choice to build a professional website. All
WordPress features are fully supported on all our WordPress hosting plans, so you can

get started in no time and create your next successful online project.
2.2 What is Content Management System?

A content management system (CMS) is an application used to create and manage
digital content. Content is what makes any organization stand out from the crowd,
content must be regular and well organized in order to maintain any branding possible
thus rather than doing it manually CMSes are used for enterprise content management
(ECM) and web content management (WCM).

An ECM is used for the collaboration in any workplace by integrating document
management, digital asset management and records retention functionalities, and
providing end users with role-based access to the organization’s digital assets. While
WCM facilitates collaborative authoring for websites. It is easy to say that WCM is a
more public content management tool whereas the ECM is totally built for more

confidential contents to be kept secured within the organization.
2.3 How does WordPress work?

WordPress, like any other WCM system, is dynamically driven through the use of a
database with multiple tables storing all the content information and the information
required to specify the website structure. You must have the ability to create and utilize

a database to use WordPress.





OEBPS/Image00052.jpg
w
W) Training kit 3 = 28 SPECIAL REPORT

SULLTT wepl

CenersiSettngs  Scanwar  Mardewing  PostMack  Alerts  APIServiceCommuncation  Website info

Hardening Options
Website Firewall Protection ==
Verify WordPress Version o
Verify PHP Version o
Remove WordPress Version o

Slock PHP s in Uploads Dvectory D
lock PHFies i WP-CONTENT Dvectry =D

— p—

These options help you lock down the key areas that hackers often use in their attacks.

The only thing we recommend customizing is ‘Email Alerts’.

The default alert settings can clutter your inbox with emails. We recommend receiving
alerts for key actions like changes in plugins, new user registration, etc. You can

configure the alerts by going to Sucuri Settings » Alerts.

-Hack Alerts API Service Communication Website Info

ary admin account, the same account created during the installation of WordPress in your web
/e a copy of the same security alerts.
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After learning about WordPress the first thing that comes to our mind is that where to
use it? What kind of website can I create using WordPress? So let’s move on to the

section straight away.

‘When launched, WordPress was nothing but a typographic improvement, but as time
passed and the community got stronger and WordPress was developed by contributors
from all over the world, now WordPress is a robust system that can be used to create
and manage any kind of website to keep it short. To showease some examples let’s look

into the various implementations of WordPress already developed.

e E-commerce Websites: WordPress is really great for E-Commerce websites
because of its robust structure and ability to categorize contents. With the proper
theme chosen to create an E-commerce website is considered to be one of the
best options available.

e Educational/Library Websites: One of the most important features of

WordPress is to manage and categorize documents or other assets, though not
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This WordPress security plugin is very powerful, so browse through all the tabs and
settings to see all that it does such as Malware scanning, Audit logs, Failed Login
Attempt tracking, ete.

8.2.3 Enable Web Application Firewall (WAF)

The easiest way to protect your site and be confident about your WordPress security is

by using a web application firewall (WAF).
A website firewall blocks all malicious traffic before it even reaches your website.

DNS Level Website Firewall — These firewall route your website traffic through
their cloud proxy servers. This allows them to only send genuine traffic to your web

server.

Application Level Firewall — These firewall plugins examine the traffic once it
reaches your server but before loading most WordPress scripts. This method is not as

efficient as the DNS level firewall in reducing the server load.

s

The best part about Sucuri’s firewall is that it also comes with a malware cleanup and

blacklist removal guarantee. Basically, if you were to be hacked under their watch, they
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‘We know that improving WordPress security can be a terrifying thought for beginners.
Especially if you're not techy. We will learn how you can improve your WordPress

security with just a few clicks (no coding required).
If you can point-and-click, you can do this!
8.2.1 Install a WordPress Backup Solution

Backups are your first defense against any WordPress attack. Remember, nothing is

100% secure. If government websites can be hacked, then so can yours.

Backups allow you to quickly restore your WordPress site in case something bad was to

happen.

There are many free and paid WordPress backup plugins that you can use. The most
important thing you need to know when it comes to backups is that you must regularly

save full-site backups to a remote location (not your hosting account).

‘We recommend storing it on a cloud service like Amazon, Dropbox, or private clouds
like Stash.

Based on how frequently you update your website, the ideal setting might be either once

a day or real-time backups.

Thankfully this can be easily done by using plugins like VaultPress or UpdraftPlus. They

are both reliable and most importantly easy to use (no coding needed).
8.2.2 Best WordPress Security Plugin

After backups, the next thing we need to do is set up an auditing and monitoring system

that keeps track of everything that happens on your website.
This includes file integrity monitoring, failed login attempts, malware scanning, ete.

Thankfully, this can be all taken care of by the best free WordPress security plugin,

Sucuri Scanner.

You need to install and activate the free Sucuri Security plugin.





OEBPS/Image00007.jpg
ndining it Gompleto WordPressraining at your | SPECIAL REPORT
fingertips t rate your success!

WordPress is one of the most widely-used blogging platforms available. WordPress is a
factory that makes webpages is a core analogy designed to clarify what WordPress is and
does. It stores the content that allows you to create & publish webpages only requiring a

domain and a hosting site to work. Let’s unveil it in detail...
2.1 What is WordPress?

WordPress is a Content Management System (CMS), which is open source and was
created to manage blogs. WordPress allows you to easily create and manage your blogs
and websites content without coding and it can be used to create a fully operational

website.

Today, WordPress is the largest self-hosted blogging tool in the world being used by
millions of websites. The best thing about WordPress is that it is an Open Source project
which can be used by anyone over the web which means you can use it for anything be it
your personal diary, your travel accounts or your views on any subject for that matter.

WordPress is an excellent platform for building a variety of websites. Besides building a
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Upon activation, you need to go to the Sucuri menu in your WordPress admin. The first
thing you will be asked to do is Generate a free API key. This enables audit logging,

integrity checking, email alerts, and other important features.

SULUTT Wp Plugin . e C D €I €5

All Core WordPress Files Are Correct

Reyien Faise Posiives

Dashboard
Firewall (WAF)

Last Logins

Settings

The next thing, you need to do is, click on the ‘Hardening’ tab from the settings menu.
Go through every option and click on the “Apply Hardening” button.
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WordPress is an open-source software which is regularly maintained and updated. By
default, WordPress automatically installs minor updates. For major releases, you need

to manually initiate the update.

WordPress also comes with thousands of plugins and themes that you can install on
your website. These plugins and themes are maintained by third-party developers which

regularly release updates as well.

These WordPress updates are crucial for the security and stability of your WordPress
site. You need to make sure that your WordPress core, plugins, and theme are up to

date.
8.1.3 Strong Passwords and User Permissions

The most common WordPress hacking attempts to use stolen passwords. You can make
that difficult by using stronger passwords that are unique for your website. Not just for
the WordPress admin area, but also for FTP accounts, database, WordPress hosting

account, and your custom email addresses which use your site’s domain name.
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Many beginners don’t like using strong passwords because they’re hard to remember.
The good thing is that you don’t need to remember passwords anymore. You can use a

password manager.

Another way to reduce the risk is to not give anyone access to your WordPress admin
account unless you absolutely have to. If you have a large team or guest authors, then
make sure that you understand user roles and capabilities in WordPress before you add

new user accounts and authors to your WordPress site.
8.1.4 The Role of WordPress Hosting

Your WordPress hosting service plays the most important role in the security of your
WordPress site. A good shared hosting provider like Bluehost or Siteground takes the

extra measures to protect their servers against common threats.

Here is how a good web hosting company works in the background to protect your

websites and data.

e They continuously monitor their network for suspicious activity

e All good hosting companies have tools in place to prevent large scale DDOS
attacks

e They keep their server software and hardware up to date to prevent hackers from
exploiting a known security vulnerability in an old version

e They have ready to deploy disaster recovery and accidents plans which allows

them to protect your data in case of a major accident

On a shared hosting plan, you share the server resources with many other customers.
This opens the risk of cross-site contamination where a hacker can use a neighboring

site to attack your website.

Using a managed WordPress hosting service provides a more secure platform for your
website. Managed WordPress hosting companies offer automatic backups, automatic

WordPress updates, and more advanced security configurations to protect your website.

8.2 WordPress Security in Easy Steps (No Coding)
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‘What you’ll want to look for instead is a button that says “Install WordPress”:
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They may try to offer upgraded installation services, but there’s no need for that. Simply
follow the instructions for installing WordPress. Once you have completed the
installation and created your WordPress login credentials, it’s time to step inside. Unless
you change your login domain (which you eventually should for security reasons), your

admin login will be located at ‘www.yourdomainname.com/wp-login.php’.

3.1.4 Step 4: Find a WordPress Theme
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There are several domain name providers online from where you can buy a domain
name. Most of the domain name providers have a domain name search tool where

you can type the name you want and it checks the availability of the domain name.
Below are the top domain Registrars you can check out:

°  GoDaddy
°  NameCheap

3.1.2 Step 2: Purchase Web Hosting and Domain

Web hosting does exactly what it says: it “hosts” websites. In other words, web hosting
companies own and manage giant web servers located in data centers around the

country (and, sometimes, the world).

It’s on these web servers where websites like yours sit, so you don’t have to buy or
manage any of the server technology yourself. You pay these companies what amounts
to monthly or annual rent for space and bandwidth on the server. Then, you can focus

on building your website in WordPress.

Next, you have to find out the best WordPress hosting service which suits your needs.
There are several web hosting companies offering different types of WordPress hosting

plans. Below are the types of WordPress hosting plans you should know about:

e Shared Hosting: Cheapest hosting plan. With shared hosting, multiple
websites share the same IP address and resources of the server including the
memory, hard disk space, and the bandwidth. (Pros: Budget-friendly plan. Cons:
Limited space, compromised speed and security)

e VPS (Virtual Private Server): With VPS plan, you will be provided a certain
portion of server resources. You will share a server with other VPS users but
there’ll limited users, not as many as in shared plan. (Pros: Secure, Option to get
more server resources anytime as your business grows. Cons: Expensive for the

small businesses and beginners.)
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e Dedicated Hosting: Very expensive plan. All the server resources are dedicated
to a single user. (Pros: Full storage, bandwidth, and full control over the server
resources, more secure. Cons: Not a cost-effective plan for small companies.)

e Managed WordPress Hosting: Managed WordPress hosting is hosting cum
WordPress management solution which provides some of the essential
WordPress tools. It is a kind of dedicated hosting specific to WordPress platform.
(Pros: WordPress-centered hosting. Cons: Quite expensive for small and

growing businesses.

While there isn’t one clear front-runner when it comes to hosting providers, WordPress
does give some solid recommendations on companies that not only work well with
‘WordPress websites but that offer affordable hosting plans. I'd suggest you start with

one of these if this is your first website.
3.1.3 Step 3: Install WordPress

There are a number of ways in which you can install WordPress. However, most web
hosting providers will provide you with an easy-to-use one-click installation process that

simplifies the whole process.
Using Bluehost as an example, here is what you need to do:

First, log into your new web hosting account:
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The first time you step foot inside the WordPress dashboard, you can’t help but marvel
at how simple it all appears to be. A management sidebar on the left, a clean interface to
work within in the center and notifications at the top. But once you start digging deeper
into WordPress, you may feel overwhelmed as you dig deeper into the layers of
functionality within the content management system. So, let’s talk about practical steps

here.
3.1 How to Create a WP Site?

The following WordPress tutorial will walk you through all the necessary steps in setting

up your first WordPress site.

e Step 1: Choose a Domain

e Step 2: Purchase Web Hosting and Domain
e Step 3: Install WordPress

e Step 4: Find a WordPress Theme

e Step 5: Install Your WordPress Theme

e Step 6: Configure Your WordPress Theme

e Step 7: Publish Your First Pages

e Step 8: Create a Menu

e Step 9: Configure Your WordPress Settings
e Step 10: Install Essential WordPress Plugins

Now, let’s start the steps in detail:
3.1.1 Step 1: Choose a Domain

First and foremost, you must get a domain name for your website. Domain name is the
online identity of your business, i.e. name of your website in the simple terms. In other
words, it is your website address or the URL which users type on the web browser’s

address bar to visit your website.
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Since WordPress doesn’t allow you to change usernames by default, there are three

methods you can use to change the username.

e Create a new admin username and delete the old one.
e Use the Username Changer plugin
e Update username from phpMyAdmin

Note: We're talking about the username called “admin”, not the administrator role.
8.3.2 Disable File Editing

WordPress comes with a built-in code editor which allows you to edit your theme and
plugin files right from your WordPress admin area. In the wrong hands, this feature can

be a security risk which is why we recommend turning it off.

pestoNe Edit Themes

id you know?

There's no need to change your CSS here — you can edit and ive preview CSS changes in the buil-in CSS aditar

Twenty Nineteen: Stylesheet (style.css)
Selected file content

1 fcharset “UTP-8°;
/.

Theme Name: Twesty Nineteen
Theme URI: httpa://github.com/NordPress/tventynineteen

Author: the WordPr

6 Author URI: wordpress .org/
escription: Our dotault these is designed to show off the power of the block edit
all the default blocks, and is built so that what you see in the editor looks like what

Nineteen is designed to be adaptable to a wide range of websi
rofit. Peaturing asple whitespace and modern sans-serif

i201 on all screen .

6

. whether you're runnin

GNU General Public License v2 or
1 Licease URE: LICENSE
12 Text Domain: ¢

bility-resdy, custom-colors, custom-sens, cus

You can easily do this by adding the following code in your wp-config.php file.

1 // Disallow file edit
define( 'DISALLOW_FILE EDIT', true );
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Choosing a domain name is a thoughtful task. Below are some of the things you must

consider while creating/ choosing a domain name:

e Keep it simple and short: Create a domain name that is simple, short and
easy to read, remember. It enhances the chance of users typing your website
address correctly on the browser.

e Suitable for your website content: Make sure that your domain name is
relevant to the content you are going to put on the website. Besides, you can also
include keywords on the domain name if it sounds good.

e Choose an appropriate domain extension: Domain extension is the suffix
such as .com, .net, .org, .edu, etc. which is added at the end of web addresses.
They have specific meaning such as .com for commercial, .org for Organizations,
and .net for network. These three extensions are the most used extensions which

you can use as per the nature of your site; however, .com is always preferred.

Besides, there are some domain name generator tools which help to create a cool brand-

able domain name.

e How to get a domain name?
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WordPress security is a topic of huge importance for every website owner. Google
blacklists around 10,000+ websites every day for malware and around 50,000 for
phishing every week. If you are serious about your website, then you need to pay

attention to the WordPress security best practices.

‘While WordPress core software is very secure, and it’s audited regularly by hundreds of
developers, there is a lot that can be done to keep your site secure. The security is not
just about risk elimination. It’s also about risk reduction. As a website owner, there’s a

lot that you can do to improve your WordPress security (even if you're not tech-savvy).

‘We have a number of actionable steps that you can take to protect your website against

security vulnerabilities.
8.1 Basics of WordPress Security
8.1.1 Why WordPress security is so important?

At its core WordPress is very secure, the CMS is audited by hundreds of expert coders
who write security into WordPress. Nonetheless, WordPress can still be hacked and

often it is due to a lack of basic security practices.

WordPress sites that are hacked can be very damaging for the owner as it inevitably
leads to a loss of reputation while also leading to financial loss. A hacker can rob a
business of its confidential user data, can install software that leads to further damage

down the road or even install malicious programs on your user’s PCs.

Google plays a strong role in policing websites. First, it can exclude potentially hacked
websites from search results — and indeed it blacklists tens of thousands of sites every
week. Google also warns users away from infected sites by displaying a warning in

Chrome. The resulting warnings can lead to a huge drop in traffic for website owners.

The responsibility for securing a website lies, of course, with the website owner. It’s no
different from business security at a physical place of business. Essentially, your website

is your premises and you need to ensure that it is secured.

8.1.2 Keeping WordPress Updated
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You can add and edit pages in WordPress from the ‘Pages’ menu in your dashboard.

Here is how Add New Page screen looks like:

Document  Bock x

Status & Visastay ~

Add title

Pages are not meant to be social in most cases thus do not include social sharing
buttons. For example, you probably don’t want others to tweet your privacy policy page

in most cases.

Similarly, pages also don’t include comments. You don’t want users to comment on your
contact page or your legal disclaimers page. There is an option to enable comments,

however, it is disabled by default for your WordPress pages.
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This is a Sample Page =

Lorem ipsum dolor sit amet, consectetur adipiscing

Discussion

elit, sed do eiusmod tempor incididunt ut labore et

dolore magna aliqua. Ut enim ad minim veniam, quis

nostrud exercitation ullamco laboris nisi ut aliquip ex Page Attributes v
ea commodo consequat. Duis aute irure dolor in

reprehenderit in voluptate velit esse cillum dolore eu

fugiat nulla pariatur.

e =

Unlike posts, pages are hierarchical by nature. For example, you can have subpages or
child pages within a page. You can easily turn a page into subpage by choosing a parent

page from Page Attributes when editing a page.

°- O |

This is a Sample Page ;
e =

Lorem ipsum dolor sit amet, consectetur adipiscing

elit, sed do eiusmod tempor incididunt ut labore et e %

dolore magna aliqua, Ut enim ad minim veniam, quis Poge Attt ~

nostrud exercitation ullamco laboris nisi ut aliquip ex

ea commodo consequat. Duis aute inure dolor in
reprehenderit in voluptate velit esse cillum dolore eu

fugiat nulla parianur
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This is a Sample Post

Lorem ipsum dolor sit amet, consectetur
adipiscing elit, sed do eiusmod tempor incididunt
ut labore et dolore magna aliqua. Ut enim ad
minim veniam, quis nostrud exercitation ullamco
laboris nisi ut aliquip ex ea commodo consequat.
Duis aute irure dolor in reprehenderit in voluptate

velit esse cillum dolore eu fugiat nulla pariatur.

Featured Image v

T ———— e

Because WordPress posts are published with time and date in mind, they are syndicated
through the RSS feeds. This allows your readers to be notified of the most recent post
update via RSS feeds.

Bloggers can use the RSS feeds to deliver email broadcasts through services like
Constant Contact, Aweber or MailChimp. You can create a daily and weekly newsletter

for your audience to subscribe to.

The very timely nature of posts makes it extremely social. You can use one of the many
social sharing plugins to allow your users to share your posts on social media networks

like Facebook, Twitter, LinkedIn, Pinterest, etc.

Posts encourage conversation. They have a built-in comment feature that allows users to

comment on a particular topic. By default, comments, pingbacks, and trackbacks are
enabled.
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Document  Block x
Status & Vissbiny v
. .
This is a Sample Post -
Categories v
Lorem ipsum dolor sit amet, consectetur adipiscing
Tags v
elit, sed do elusmod tempor mcdidunt ut labore et
dolore magna aliqua. Ut enim ad minim veniam, Featused Image v
quus nostrud exercitation ullamco labonis nisi ut Excerpt v
aliquip ex ea commodo consequat. Duis aute wure :
Discussion
dolor n reprehendent in voluptate velit esse cillum
dolore eu fugiat nulla panatur

You can go to your Settings » Discussion to turn off comments on older posts if you like.

WordPress posts usually have the name of the author and published/updated date.

After the main article content, there is the comments section. You cannot usually find
these on a page. Now that you know what are posts, let’s take a look at pages and how

they are different.
7.2 What are Pages in WordPress?

Pages are static “one-off” type content such as your about page, privacy policy, contact
page, etc. While the WordPress database stores the published date of the page, pages are

timeless entities.

For example, your about page is not supposed to expire. Sure you can go back and make
updates to it, but chances are you will not have about page 2012, about page 2013, ete.
Because there is no time and date tied to pages, they are not included in your RSS feeds
by default.





OEBPS/Image00039.jpg
— T

W) Trainingit
' CHAPTER 7.

| 1

What, Why, & Hows of WP Salts
& Security Keys






OEBPS/Image00040.jpg
.
W=) Training kit m S mpieie A { SPECIAL REPORT

W

Often WordPress beginners get confused between posts and pages. By default,

WordPress comes with two content types: posts and pages.

As a beginner, you are probably wondering what’s the difference between posts vs

pages? They seem to look similar in the WordPress dashboard as well as on the website.
7.1 What are Posts in WordPress?

Posts are blog content listed in reverse chronological order (newest content on top). You
will see posts listed on your blog page. If you are using WordPress as a blog, then you

will end up using posts for the majority of your website’s content.

You can add and edit your WordPress posts from the ‘Posts’ menu in your dashboard.

Here is how Add New Post screen looks.

Add title

Categores v

WPFoems Featured image v

Appearance Excerpt v

Due to their reverse chronological order, your posts are meant to be timely. Older posts
are archived based on month and year. As the posts get older, the user has to dig deeper

to find them. You have the option to organize your posts based on categories and tags.
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Step 2: On the left-hand side, you can see the public_html folder where you’ll find the

wp-config file.

© Collapse Al

= # (/home/a21y1yr2mdvo)
8 application_backups
i et
logs
mail

public_htm!

Name size

W ogibin 4K8

W pradeep 4K

@ wp-admin 4kK8

i wp-content 4K8

W wpinciudes 12KB

B | 404.shtmi 166 KB
ermor_log 328Mm8
home.htmi 192K8
indexphp 418 bytes

& layoutstyles.css 4.18KB

T license.txt 19.47 KB
wp-activate.php 533K8
wp-blog-header.php 364 bytes
Wp-comments-post. php 184 K8

1| wp-config-sample.php 273K8

—

‘Wp-cron.php 358 K8
wp-inks-opmi.php 237K8
wp-oad.php 323K8
wp-ogin.php 36.88 KB
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Step 3: Right click on the file and select Edit.

& Download

@ View

& Edit €—
% Move

Copy

[ Rename

P Change Permissions I
% Delete

# Compress

Replace the ‘put your unique phrase here’ with the variables you just generated.
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A key example of this in action would be our Blueprint page. This feature allows you to

organize your pages together, and even assign a custom template to them.

WordPress by default comes with a feature that allows you to create custom page
templates using your theme. This allows developers to customize the look of each page

when necessary.

In most themes, post and pages look the same. But when you are using your page to
create a landing page or a gallery page, then the custom page templates feature comes in

very handy.

Pages also have this archaic feature called ‘Order’ which lets you customize the order of
pages by assigning a number value to it. However, this feature is extended by plugins

like Simple Page Ordering that allows you to drag & drop the order of pages.

7.3 When to Use WordPress Pages
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Having a great website matters. It’s how you connect with your visitors and leads, create
a positive first impression with new users, and boost conversions. The good news is
creating your own website doesn’t have to be a daunting process... At least not with

WordPress.

The easy-to-use CMS offers completely customizable plans suitable for all needs. With
no prior knowledge necessary, you can start building your own site for your business,

blog, portfolio, or online store immediately.

WordPress is a very user-friendly and interactive way to host your website. And this ‘WP
Training Kit’ training guide showed you how easy it is to install this CMS. One of the
reasons why WordPress gained such massive popularity was its ability to customize and
edit, as per the needs directly from the backend without hiring any professional or

writing a single line of code.

But, that’s not just about it, there’s so much more. That being said, one thing is for sure -
with a few tips and tricks, a lot can be done using WordPress. On the same lines, we
hope that this ‘WP Training Kit’ training guide will help you in creating your WordPress
website quickly and easily.

Enjoy Your Success!
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After you have selected the file, you need to click on the install now button.

WordPress will now upload the plugin file from your computer and install it for you. You

will see a success message like this after the installation is finished.

Installing Plugin from uploaded file: envira-gallery.zip

Unpacking the package...
Installing the plugin...

Plugin installed successfully.

Activate Plugin | Return to Plugins page

Once installed, you need to click on the Activate Plugin link to start using the plugin.

You would have to configure the settings to fit your needs. These settings will vary for

each plugin, therefore, it cannot be discussed in general terms.
5.2.3 Manually Install a WordPress Plugin using FTP

In some cases, your WordPress hosting provider may have file restrictions that could

limit your ability to install a plugin from the admin area.
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Installing Plugin: Floating Social Bar 1.1.7

Downloading install package from https://downloads .wordpress.org/plugin/floating
Unpacking the package...

Installing the plugin...

Successfully installed the plugin Floating Social Bar 1.1.7.

Activate Plugin | Return to Plugin Installer

The next step is to configure the plugin settings. These settings will vary for each plugin,

therefore, it cannot be discussed in general.
5.2.2 Install a Plugin using the WordPress Admin Plugin Upload

Paid WordPress plugins are not listed in the WordPress plugin directory. These plugins

cannot be installed using the first method.

That’s why WordPress has the Upload method to install such plugins. We will explore

how to install WordPress plugins using the upload option in the admin area.

First, you need to download the plugin from the source (which will be a zip file). Next,
you need to go to the WordPress admin area and visit Plugins » Add New page.

After that, click on the Upload Plugin button on top of the page.
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On the other hand, tags are like the index page. If your website was a file cabinet,
tags would be the labels on individual file folders.

11. Not Using Posts and Pages Properly: Sometimes beginner WordPress users
end up using posts to create important website pages. Similarly, some users end
up using pages for articles when they should have used posts instead.

A lot of users realize their mistake after a while when their website becomes
difficult to manage.

Basically, pages are for static pages that don’t change very often like about,
contact, privacy policy, etc.

On the other hand, posts are for time-based content like news, updates, articles,
and blogs.

12.Not Choosing The Right URL Structure (Permalinks): Selecting the right
URL settings (permalink structure) for your website is really important.
Changing your URL structure later is not easy, and it can have a significant

impact on your website traffic.

(o Plain http://localhost/mysite/2p=123
Appearance
e Day and name http://localhost/mysi te/2019/05/16/sample-post/
 Plugins
Users
* Month and name http://localhost/mysite/2019/05/sample-post/
Tools
Settings Numeric http://localhost/mysite/archives/123
Post name http://localhost/mysite/sample-post/
Custom Structure http://localhost/mysite /Xyeark/Xmonthnus/¥post
Available tags:
Permalinks
%yeark || %monthnum% | %day% = %hour% | %minute!

We recommend going to the Settings » Permalinks page in your WordPress
admin area and choosing a URL structure with that shows your post name in the
URL.
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This will bring you to the plugin upload page. Here you need to click on the choose file

button and select the plugin file you downloaded earlier to your computer.
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choose File  No file chosen
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13.Ignoring Website Speed and Performance: Human attention span is
dropping rapidly, and users want instant gratification. With faster internet
connections, your users would find a few extra seconds of page load time to be
extremely slow.
And it’s not just users, even search engines rank faster websites higher in their
results. By ignoring website speed and performance you risk user experience as
well as search rankings.
Which is why you need to make sure that your website loads fast.
14.Not Choosing The Right Plugins: The real power of WordPress comes with
its plugins. There are thousands of free WordPress plugins that you can install
with a few clicks.
However, not all plugins are good. In fact, some plugins are bad and could affect
your website’s performance and security. Often users end up downloading
plugins from unreliable sources that distribute hidden malware.
Here are a few things you need to keep in mind when choosing plugins:
e Only install plugins from WordPress.org or WordPress companies with a
good reputation.
e Look for plugin reviews and support forums because they are a good
indicator of a plugin’s quality
e Check trusted WordPress resources like WPBeginner for plugin
recommendations

15.Ignoring WordPress Security Best Practices:
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e Uploading a WordPress plugin
e Manually installing a WordPress plugin using FTP

5.2.1 Install a Plugin using WordPress Plugin Search

The easiest way of installing a WordPress plugin is to use the plugin search. The only
downside of this option is that a plugin must be in the WordPress plugin directory which

is limited to only free plugins.

First thing you need to do is go to your WordPress admin area and click on Plugins »
Add New.

Dashboard Add Plugms Uplo.dPIung i N

A Posts
Featured Recommended Bar
0 Media
N Pages Plugins extend and expand the functionality of WordPress. You may automatically instal

WordPress Plugin Directory or upload a plugin in .zip format via this page.
Comments

Appearance bbPress + . Je
w

Install Now

More Details
bbPress is forum Me
software, made the Yo
WordPress way. Sir
8y The bbPress 8y

Community
e koo 7y 613

You will see a screen like the one in the screenshot above. Find the plugin by typing the
plugin name or the functionality you are looking for like we did. After that, you will see a

bunch of listings like the example below:
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This allows your website visitors to become familiar with your website, your
brand, and its unique style. Consistency and continuity of your design make a big
impact on brand recognition and awareness.
Well, when it comes to design we prefer simplicity over glitter. You need to
choose a great looking but simple WordPress theme that pays attention to the
following items:

e It must look equally good on all devices (desktop, mobile, and tablets).

e It should be easy to customize and flexible to adapt to your needs.

o It should work with popular plugins and WordPress page builders.

e It should be optimized for performance and speed.
Now we understand that as a non-techy user, you may not be able to check all
those things on your own but do your best.

8. Ignoring WordPress Updates: Many beginners and even experienced

WordPress users who don’t install updates on their site. Many of them believe
that doing so will cause errors and could break their site.

That’s not true.

@ Dashboard WordPress Updates

Ko I Important: before updating, please back up your database and files. For help with
Updates s

Last checked on May 16, 2019 at 2:00 am. Check Again
A Posts

Q) Media An updated version of WordPress is available.

I Pages You can update to WordPress 5.2 automatically:

® Comments Update Now

2 Appearance While your site is being updated, it will be in maintenance mode. As s00n as your upd:

Plugins @

Plugins
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You can pick the plugin that is best for you. Since in our search, we were looking for
Floating Social Bar which happens to be the first plugin, we will click the ‘Install Now’
button. WordPress will now download and install the plugin for you. After this, you will

see the success message with a link to activate the plugin or return to plugin installer.

A WordPress plugin can be installed on your site, but it will not work unless you activate
it. So go ahead and click on the activate plugin link to activate the plugin on your

WordPress site. That’s all; you have successfully installed your first WordPress plugin.
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You can easily and safely update WordPress without breaking your website. By
not updating WordPress, you leave your website vulnerable to security breaches
while using outdated software.

It’s not just WordPress, your WordPress theme and plugins also regularly release
updates for bug fixes, security patches, and new features.

Not Optimizing Your Website for SEO: A lot of WordPress users rely on
their best guesses when it comes to promoting their websites. Some completely
ignore SEO, while some do it half-heartedly.

SEO (Search Engine Optimization) helps you rank higher in search engines, so
more users can find your website.

Search engines are the biggest source of traffic for most websites. SEO is crucial

for the success of your online business.

10. Not Using Categories and Tags Properly: Another big mistake is not

4]

f Posts All (24) | Mine (23) | Published (13) | Drafts (11) | Trash (2)

. - ——
All Posts Bulk Actions %  Apply All dates 4 All Categories %
Ad
Categories

Tags

%

using categories and tags properly. Some users end up using categories where

they should have used tags and vice-versa.
‘We have seen websites with dozens of categories and no tags at all. We have seen

websites using hundreds of tags and no categories at all.

Dashboard Posts Add New

d New Title

10 Expert Tips on Finding The Best Hotel Deals — Draft

Media 10 Amazing Coffee Shops in NYC — Draft

Basically, categories are your website’s table of contents. If your website was a file

cabinet, categories would be its drawers.
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3. Not Setting up Automated Backups: Each year billions of dollars worth of
damages are caused by data loss. Almost every website on the internet is prone to
accidents, theft, hacking attempts, and other disasters.

Your most powerful line of defense against these threats is automated backups.
Without a backup, you could lose all your WordPress data, and it would be very
difficult to recover it (sometimes even impossible).

Setting up backups is extremely easy, and there are excellent WordPress backup
plugins available in the market. Once you set up one of these backup plugins, they
would automatically create backups for you.

The second part of this mistake is not storing backup files on a remote location. A
lot of folks store their WordPress backups on their web hosting server. If they
lose their website data, then they also lose the backups.

Make sure that you store your backups on cloud storage service like Google Drive,
Dropbox, ete. Backup plugins like UpdraftPlus can automatically do that for you.

4. Not Setting up Google Analytics: If you want to grow your business with
confidence, then you need to know how people find and use your website. That’s

where Google Analytics can help.
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There are thousands of WordPress plugins available for free at the official WordPress
plugin directory. Aside from free plugins, there are tons of amazing commercial ones

available from third-party companies and developers.

As a site administrator, you can install/uninstall plugins from the admin area. You can

also download and manually install them using an FTP client.

Because the vast majority of plugins are free, it is important to note that they usually do
not come with tech support. For this reason, it is important to be careful when choosing

which ones you want to install on your site.

Although there are plugins that can do the task you want them to do, some are much
higher quality than others. In order to choose the right ones, you should ask yourself a

couple of questions.

How long has it been since it was updated? Is it compatible with the latest version of
WordPress? Are people getting answers to their support questions? What type of rating

does it have?

There is a myth that WordPress plugins slow your site down. It is not true. Only the

number of bad ones will slow down your site.
5.2 How to Install a WordPress Plugin — Step by Step for Beginners

After installing WordPress, the first thing every beginner needs to learn is how to install
a WordPress plugin. Plugins allow you to add new features to WordPress such as add a
gallery, slideshow, ete. There are thousands of free and paid plugins available for
WordPress. But before you start, if you are using WordPress.com, then you cannot
install plugins. WordPress.com has its limitations. You cannot install plugins on
WordPress.com unless you upgrade to their business plan. On the other hand, you can
install any plugin you want on your self-hosted WordPress.org website right out of the

box.
Installing a WordPress plugin involves three methods:

e Installing a WordPress plugin using search
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We recommend using MonsterInsights, the most popular Google Analytics plugin
for WordPress. It saves you time during setup, and shows you the stats that
matter, right inside your WordPress dashboard.

If you don’t want MonsterInsights Pro, then there’s also a free version of
MonsterInsights available that you can get started with.

5. Not Setting up a Contact Form: Not setting up a contact form is another
easily avoidable mistake that many beginners make. Without a contact form, your
website visitors will not be able to contact you, and this can cause you to lose
significant opportunities.

You will see a contact page on almost every popular website. It is one of the most
important pages every website need to have.

WordPress does not come with a built-in contact form, but there are a lot of great
WordPress contact form plugins available that you can use.

‘We recommend using WPForms Lite which is the free version of the popular
WPForms plugin that’s being used by over 2 million websites.

6. Not Building an Email List: Did you know that more than 70% of people who
visit your website will never come back again?

If you are not building your email list, then you are basically losing money with
every website visitor that leaves your site. Converting website visitors into email
subscribers allows you to bring back those users to your website.

You will need an email marketing service to set up your email list. We
recommend using Aweber because they are one of the best email marketing
companies on the market with a very beginner-friendly platform.

7. Not Choosing The Right WordPress Theme: One of the biggest challenges
WordPress beginners face is choosing the right design for their website.

With thousands of WordPress themes out there, an average beginner tries
multiple themes before settling for the right one, and this process can even lead
the user to rebuild their website multiple times.

To avoid this, we recommend choosing the right WordPress theme from the start

and then stick to it.
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The first one is used only when you are logged onto your Dashboard while the second
cookie is used throughout WordPress to ensure whether or not you are logged in. The
details you use to log in are hashed (assigned cryptic values) using the random variables
which are then specified in the WordPress security keys. This, in turn, strengthens and
makes it almost impossible for anyone to guess your password should your cookies be

stolen.
6.3 How to Use WordPress Security Keys and Salts?

Usually, when your WordPress websites are self-hosted, the security keys are not pre-
defined. Instead, you might need to generate and add them yourself. But don’t worry,
the process is quite simple and straightforward. Generally, there are two ways you can
configure the secret key. We will be discussing both methods for your convenience so

you can choose whichever method you prefer.

e Manually change the WordPress Security Keys and Salts
e Using a WordPress Plugin

Method 1: Manually Changing the Secret Keys & Salts!
Follow the steps below as a guideline and secure your WordPress profile and website!

You can easily change WordPress security keys and salts. The WordPress Foundation
provides a WordPress key generator that creates random values for secret keys and

salts. Visit the following link: https://api.wordpress.org/secret-key/1.1/salt/

Copy the values you get from the link and then paste it in your wp-config file.

Step 1: To access the wp-config.php, open your web host account and go cPanel. Select
File Manager, and it’ll take you to a page that looks somewhat like this:
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When it comes to protecting your WordPress website, the login screen is an important
line of defense. A significant part of this is making sure your password is secure, which

makes it far less likely that attackers will be able to crack it and gain access.

Despite the measures you take to implement good login practices, leaving your site’s
security to users is not a good idea. This is why WordPress uses a set of security keys or

secret keys. Let’s find out about them...
6.1 What Are WordPress Security Keys & Salts?

WordPress Security Keys is a set of random variables that improve encryption of

information stored in the user’s cookies. There are a total of four security keys:

o AUTH_KEY

o SECURE_AUTH_KEY
o LOGGED_IN_KEY

¢ NONCE_KEY

*~ON[Wgu| Tugrp! DX)TF$Z'DSQndISb-LeSXcQR5?; |)X.PSXIV| §46 ~=a=ng’

*{ICpTAUS{Lz{h0. . ~pb4-SquOgN & e WordPress
'y34¥0k mNYx21Q25+3 | X0; [hO=5]XpvS~684948
a2 B PINBIEFD NS tSVeSHBerasy T sTTSi orecese'y; ) KEY'S
“TI{S™VIQYi+15(+B<)~>: VRI#YA_; JHI6ST N <~#pSw; 1;YF ;x| 7UnOWY
define(’ SECURE_AUTH_SALT’, '}*h+Ta 27}:v6[0Gs, _YnS}coMFW/h@)eJAanION] 1. 14>7CtovIxufSK<N' WordPress
define('LOGGED_INSALT',  *|'SStw{*IvU+>A,=HIRBYCALS=,e|_.!fF &n_|z_IR| UD 1n@SP-VSY|nd;;]2’
define( 'NONCE_SALT", 'NQRXX+HU;R 4 30W0: 15hoq=Tq(RH4nyS; B+961M8 # |K1§I6W| | -RGDESCUN salts

Salt keys are cryptographic elements used to ‘hash’ data in order to secure it. In fact,
most serious platforms and systems use similar mechanisms to protect sensitive data.
The process works by using the salt keys to encrypt your password when you save it in
WordPress. This way, attackers can’t see your passwords in plaintext even if they

somehow gain access to your database.
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Salt keys are also used to sign your website’s cookies. This stops malicious actors from
being able to gain access even if they can take over your cookies. All of this happens in
the background, and there are zero reasons why you’d ever need to share your
WordPress salt keys with a third party. If someone were to get their hands on them,
they’d might be able to use them in order to access your passwords and crack your

website.

You can find both WP salts and security keys in the wpconfig.php file. WordPress
generates four security keys and salts in the wp-config.php file. After a fresh WordPress
install, this is how the WordPress secret keys and salts look:

e define((AUTH_KEY’, ‘put your unique phrase here’);

e define(‘SECURE_AUTH_KEY’, ‘put your unique phrase here’);
e define('LOGGED_IN_KEY’, ‘put your unique phrase here’);

e define(NONCE_KEY’, ‘put your unique phrase here’);

e define((AUTH_SALT’, ‘put your unique phrase here’);

e define(‘'SECURE_AUTH_SALT’, ‘put your unique phrase here’);
e define((LOGGED_IN_SALT’, ‘put your unique phrase here’);

e define(NONCE_SALT’, ‘put your unique phrase here’);

You need to generate security keys and WordPress salts and replace the ‘put your unique

phrase here’ with random variables you just generated.
6.2 How Does WordPress Salts and Security Keys Work?

Unlike most of other websites platforms, WordPress does not use the PHP sessions to
keep track of their users. To verify an identity of logged in users as well as commenters,
WordPress usually uses the cookies or information that are stored in your browser’s
history. When you log in to your Dashboard multiple cookies are created and saved.

Usually, the two cookies that are created are:

e wordpress_[hash]
e wordpress_logged_in_[hash]





